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I. Introduction

A. Instrument Function Overview

The MS1500L is a hand-held measurement and data collection
device. ltis lightweight, easily handled, and battery operated so
that it can be carried to any location where measurement or data
collection is required.

The MS1500L has several measurement functions:

e 3-Electrode Linear Polarization (corrosion-rate)
e 2-Electrode Linear Polarization (corrosion-rate)
e “Pitting Index”

e Zero Resistance Ammetry

e Electrode Potential

This versatility allows the unit to be used with all commercially
available corrosion-rate probes. Additionally, it can be used with
all types of galvanic probes to measure bimetallic corrosion,
changes in the oxidizing power of the process fluid and, with
suitable electrode combinations, crevice and pitting attack, as
well as stress corrosion cracking.

Using galvanic probes with an appropriate combination of
corroding, redox, and reference electrodes, it is possible to
measure the corrosion potential of a corroding electrode, or the
redox potential of the process fluid, which provides a wide range
of information on such phenomena as active/passive transitions,
inhibitor film persistency, inhibitor mechanisms, cathodic
protection criteria, as well as providing an alternative means to
measure the onset of pitting a crevice attack and conjoint action
failure phenomena (e.g., stress cracking).



All measurements made with the MS1500L may be stored in the
onboard memory that will hold as many as 3000 readings from
up to 100 individual probes. All stored data may be called to the
instrument screen and reviewed at any time. A backup battery
will hold all data stored in memory for up to 12 months, in event
of failure of the main instrument battery.

Data may be selectively deleted from memory to accommodate
additional information, once the 3000 reading capacity is reached.
Alternatively, information may be downloaded to a PC as a
comma-delimited ASCII file for import into any of the standard
data analysis (spreadsheet) program such as Microsoft Excel.

In addition to its measurements function, the MS1500L may

be used as a data collection and transfer terminal for Metal
Samples’ MS3500L remote LPR data logger. In this capacity the
accumulated data from several MS3500L field-based units may be
locally downloaded to the portable MS1500L and transferred to a
PC for further analysis.
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B. Instrument Parts List

The MS1500L comprises the following items:

Part No. Qty. Description

M-7500-M 1 Operations Manual

IN1500L-3 1 Meter Prover

ET0352 1 Serial Port Cable

IN1500-3 1 9-Pin Serial Port Adapter
IN1500L-5 1 6-Pin Cable to 5-Pin Probe Adapter
MS1500L 1 Instrument

IN1500L-2 1 Instrument Carrying Case
B-8400-B 1 9-Volt Battery

IN3500L-4 1 Galvanic Probe Adapter

The user should check, upon receipt, that the above accessories
are included with the MS1500L unit. Any shortage should be
reported immediately to:

Metal Samples Company
152 Metal Samples Rd.
Munford, AL 36268
Phone: (256) 358-4202
Fax: (256) 358-4515
E-mail: msc@alspi.com



C. Specifications

Model

MS1500L - Handheld LPR Corrosion Data Logger (Ordering #IN1500L)

Physical Data
Instrument Weight:

Total Weight w/ Carrying Case
and Accessories:
Instrument Dimensions:

Carrying Case Dimensions:

Operating Temperature:
Storage Temperature:

Performance Data

1.4 Ib. (0.64 Kg)

5.26 Ib. (2.39 Kg)

7.63"Hx 4.15"W x 2.0"D
(19.38cm x 10.54cm x 5.08cm)
10”"H x 11.75”"W x 5.4”D
(25.40cm x 29.85cm x13.72cm)
32°to 122°F (0° to 50°C)

-4° to 158°F (-20° to 70°C)

Measurement Type Range Resolution
2-Electrode 0 to 200 mpy 0.01 mpy
3-Electrode 0 to 150 mpy 0.01 mpy
Galvanic +999 pA 1pA
Potential +999 mV 1mVv

Electrical Data

Power Requirements:

Maximum Probe Cable Distance:
Output Specifications:

Special Features
e Microprocessor-based electronics

One 9V Battery

6 ft (1.83 m)

RS-232 Output in Comma-
Delimited ASCII Text Format

¢ Data storage capacity of 3000 readings on 150 different probes, with

battery backup

e Menu-driven interface using a 12-key keypad and a 4-line LCD display

¢ Low-battery detection
e Portable

Accessory Items

Carrying Case, 6’ Probe Cable (attached), Meter Prover, 6 to 5-Pin
Adapter, Galvanic Adapter, Communications Cable and Connector,

Operation Manual



D. Battery Installation

Open the battery compartment by removing the “slip-fit” cover
on the rear of the instrument (shown below) and insert one 9-volt

battery.

FRONT BACK

yT—"SLIP-FIT" BATTERY COVER

19V BATTERY

PROBE CONNECTOR

Figure 2. Battery Installation



E. Computer Download Hook-Up

Use this cable to connect the MS1500L to a computer via serial
port or USB port.

COILED DATA CABLE

MS1500 SERIAL
PORT ADAPTER

compUTER DU0
SoRT 0og
000

SERIALTO USB
ADAPTER (OPTIONAL)

COMPUTER
usB
PORT

Figure 3. Computer Download Hook-Up

Use the port on top of the Top View of MS1500L
MS1500L for connecting to a
computer (with the cable [ |

provided) or to the MS3500L \ L '
(with the Opti-link cable.)
See Communications (p. 32) for more information.
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F. Adapter Use

The probe connector on the MS1500L is a six-pin, female,
MIL-SPEC (MS-3106F-14S-6S) fitting. It is designed for direct
connection to any standard electrochemical probe manufactured
by Metal Samples (see illustration below).

MS1500L
[ PROBE CABLE CONNECTOR

2 ELECTRODE PROBE

Figure 4. Conventional Probe / Instrument Connection



The IN1500L-5 (6 to 5 pin adapter) is a special adapter designed
to mate with all two- or three-electrode probes that use a five-pin
connector instead of the conventional six-pin connector.
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MS1500L
ABLE CONNECTOR

Figure 5. Adapter Connection for 2- or 3-Electrode Probes

The user may, from time-to-time, encounter probes with a non-
standard probe connection, especially if the probes are of a non-
commercial variety. To account for this possibility, the IN1500L-4
cable adapter is available. This comprises a conventional six-pin
connector, attached to a cable with leads, terminated in alligator
clips. This allows for individual terminations to be made to any
non-conventional probe, provided the probe connector pin-out is
known. If the user is unfamiliar with the pin-out on any particular
probe, this can be established prior to probe installation by
performing a simple continuity check between the probe

electrodes and the probe connector pins.



Il. Instrumentation Operation

A. Start-Up and Operations Overview

Having installed the battery, as discussed on page 6, the unit is
ready for operation. The instrument may be activated, using the
toggle switch on the left side of the base of the instrument.

When switched on, the instrument will initially show the self-test
screen, display the free storage, then automatically jump to instru-
ment functions as shown below:

Metal Samples
MS1500L V/X.X “SYSTEM TEST SCREEN”

SYSTEM TEST: XXXX

AUTOMATIC

Metal Samples
MS1500L V/X.X “FREE STORAGE SCREEN”

FREE STRORAGE: XXXX

AUTOMATIC

> SELECT PROBE I.D.
MAKE MEASUREMENT
RECALL READINGS
DELETE READINGS

“MAIN FUNCTION SCREEN”

UNS CONST. TABLE
COMMUNICATIONS
SET TIME & DATE

10



The initial screen showing the system test will scroll the four digit
number until it has counted all the free storage. The free storage
is then displayed on the second screen, which appears automati-
cally.

A new instrument should show a free storage of 3000. If a
number lower than 3000 is shown, the instrument contains
stored data from factory testing. Any such data should be
located through the “SELECT PROBE I.D.” function and deleted
(see Select Probe I.D., p.14, and Delete Readings, p.27 ).

Once the free storage has been displayed, the screen moves
automatically to the instrument function screen. This screen
shows a series of cursor-selectable options that allow the user
to enter data, or perform some measurement or action.

Prior to any other action, the user should use the down arrow
on the keyboard to select “SET TIME AND DATE,” followed by the
enter key to access the function sub-menu screens that have the
following sequence:

SET TIME & DATE
HH:MM  DD/MM/YR

UP ARROW WHEN DONE

SET TIME & DATE
HH:MM  DD/MM/YR

ENTER TO ACCEPT

11



Individual digits of the date and time can be set using the key-
board numbers. Once an individual group (e.g., hours) is set, the
up arrow will shift the user to the next group of digits to be set.
Once the year group digits are set, the up arrow will bring up a
confirmation screen, the command “enter” will set the time and
date as shown. An “exit” command will leave the time and date as
previously set. Whether the “enter” or “exit” command is applied,
the user will be returned to the function screen automatically. At
this point, the user may either re-enter the “SET TIME AND DATE”
submenu to enter the correct time and date or, if satisfied with
the current time and date function, proceed to other measure-
ments or data input.

The instrument clock will run on backup battery should the main
battery fail so, once the time and date is originally entered, there
should not be reason to further reset this parameter. Should

the user decide for any reason to reset the time and date after
the initial setting, the time continuity of any stored data will be
disrupted and data will prove tedious to analyze subsequent to
the time change.

The purpose of the remaining menus displayed on the function
screen is described in detail in subsequent sections of this manual.
However, the following gives a brief overview of these functions,
and their use:

SELECT PROBE I.D.: This allows a probe to be given a
unique reference number, a selected
measurement mode, an electrode
alloy identification and, where
necessary, a measurement time cycle
and electrode area modifying factor.

MAKE MEASUREMENT: This instructs the instrument to make a
measurement, and save the resulting
data.

RECALL READINGS: This allows the stored data from any or
all probes to be called to the instrument
screen and reviewed.

12



DELETE READINGS:

UNS CONSTANT TABLE:

COMMUNICATIONS:

SET TIME AND DATE:

This permits the deletion of redundant
or obsolete data from memory.

This permits the insertion of correction
factors when the user employs electrodes
of nonstandard surface area.

This executes the download of data
from the MS1500L to a PC, for further

processing and analysis.

This allows the user to alter the setting
of the instrument clock.

13



B. Select Probe I.D.

1. General

This function menu is central to the whole operation of the instru-
ment. With the exception of the “UNS CONSTANT TABLE” and the
“SET TIME AND DATE”, no function menu can be used prior to the
selection of a probe I.D. The menu allows you to identify a specific
probe with data already in memory, for which the user requires

to make additional measurements, review existing data stored for
that probe, or delete data for the probe selected. It also allows
the user to enter a new probe I.D., together with a requirement
measurement function, alloy identification, and time cycle (if
required).

The “SELECT PROBE I.D.” function may be entered by selecting this
option on the main function screen using the cursor, then pressing
the “ENTER” key. The initial submenu screen will appear as shown
below:

ENTER NEW PROBE
DELETE PROBE

XXXX XXXXX XXXXXX
XXXX XXXXX XXXXXX
XXXX XXXXX XXXXXX

The screen lists options for entering a new probe, deleting a probe
and also lists all identities for probes with data already stored in
memory. Those probes already in use are listed as a four-digit I.D.
number, three to five letters and digits describing the measurement
type, and single letter followed by five digits designating the UNS
alloy code (p. 57 lists the most common alloys and their UNS
codes).

If the user simply wishes to make a measurement, recall readings,

delete reading, or download data for an existing probe, the specific

probe is selected, using the cursor and arrow keys, followed by the
14



“ENTER” key. The probe is now selected, and the user will be
returned to the main function screen to make a measurement,
recall readings, delete readings, or download data for the probe
selected.

2. Enter New Probe

Whenever a new probe location is to be monitored, the user will
need to enter a unique probe I.D. number, an instruction as to
measurement type, and an alloy designation code. To do this,
select “ENTER NEW PROBE” from the initial screen of the sub-
menu using the cursor and arrow key, and activate the option with
the “ENTER” key. This will initiate the following screen sequence:

PROBE ID: __

UP ARROW WHEN DONE
PROBE ID: XXxx < UP ARROW
PROBE ALREADY EXISTS PROBE ID: XXXX
ENTER TO DELETE ALL UNS NUMBER:
OLD PROBE READINGS USE ARROW KEYS

ENTER
UP ARROW

ALLOY CONST.
ALREADY STORED
IN MEMORY

EXIT PROBE ID: XXXX
UNS NUMBER: LXXXXX
ALLOY CONST: _ . _
UP ARROW

WHEN DONE

ESELECT PROBE ID:
‘MAKE MEASUREMENT
'RECALL READINGS
.DELETE READINGS

AUTO

v
PROBE ID: XXXX

UNS NUMBER: LXXXXX
MEASUREMENT: LPR3A
USE ARROW KEY

UNS CONST TABLE
COMMUNICATIONS
SET TIME AND DATE

A
GALV.

ENTER POT.

A
PROBE ID: XXXX
UNS NUMBER: LXXXXX
TIME CYCLE: O5 MIN.

USE ARROW KEY PROBE ID: 444
UNS NUMBER: LXXXX
ENTER MEASURMENT: GALV.

ENTER TO ACCEPT

ENTER

PROBE ID: XXXX

UNS NUMBER: LXXXXX
LPR3A 5 MIN. CYCLE
ENTER TO ACCEPT

EXIT

iing

15



The initial screen allows the user to insert a probe I.D. of up to
four digits, using the keyboard numbers. When the appropriate
I.D. number is entered, which may be any digital sequence the
user cares to adopt, the “UP ARROW” key will transfer the user to
the next screen.

If the user has selected a probe I.D. already in use, the menu

will divert from the normal sequence, inform the user that the
selected 1.D. is already in use, and ask if old probe readings are
to be deleted. Unless the user wishes to delete existing probe
readings, the “EXIT” key should be selected, which will return the
user to the main function menu, allowing re-entry to the “SELECT
PROBE 1.D.” menu, so that the user may select a probe I.D. that
is not in use. Should the user wish to delete readings already
stored under the selected probe I.D., “ENTER” should be selected,
existing probe readings will be deleted, and the probe I.D. will be
free for reuse.

Assuming a unique probe I.D. has been selected, or the user has
elected to delete existing data as described in the previous para-
graph, a screen will be shown allowing entry of the UNS code for
alloy identification. This will be a letter, followed by a five-digit
number.

For most measurement applications, the UNS code is merely used
as reference data. However, in the case of a 2-electrode, linear
polarization measurement, the UNS number will trigger the use
of an alternate proportionality constant in the instrument’s cal-
culation of corrosion rates. (See UNS Constant Table, p.57.)

The initial letter of the UNS constant is selected from the key-
board, and confirmed using the “ENTER” key. The subsequent
five digits are selected using the keyboard and confirmed using
the “UP ARROW” key. The screen will automatically change to the
alloy constant screen or the measurement type screen.

16



If the UNS code entered for this particular probe is already con-
tained in “UNS CONST. TABLE”, the instrument will already have a
record of the alloy constant, and will pass directly to the measure-
ment type screen, if not the instrument will automatically pass to
the alloy constant screen. The alloy constant screen allows the
user to input a two-digit number from the keyboard. This will be

a number less than ten given to the first decimal place, using the
“UP ARROW” when complete to pass to the measurement type
screen.

The alloy constant is a correction factor used to account for
variation in electrode surface area when making a two-electrode
corrosion rate measurement. A look-up table for forty-five of
the commonest alloy constants is programmed into the MS1500L
and, should the user select one of these alloys, the instrument
will automatically enter this constant without showing the alloy
constant screen. Additional alloy constants are automatically
added to the look-up table as the user programs them through
the “SELECT PROBE 1.D.” menu; alternatively they can be added
directly to the look-up table through the “ALLOY CONST. TABLE”
menu (see UNS Constant Table, p. 57). The look-up table will
hold a maximum of fifty alloy constants together with their UNS
codes, so that the user may occasionally wish to delete alloy
constants and UNS codes to make room for more frequently used
designations; this is also accomplished through the

“ALLOY CONST. TABLE” menu. (A table of common UNS codes,
together with appropriate alloy constants is given on p.57).

The measurement type screen, which is shown automatically after
the UNS code screen or the alloy constant screen, allows the user
to select the measurement type by using the “ARROW” keys to
scroll, and the “ENTER” key to select. The measurement types
that are selectable are:

17



LPR3A: 3-electrode, linear polarization (corrosion rate)
using anodic polarizing current.

LPR3C: 3-electrode, linear polarization (corrosion rate)
using cathodic polarizing current.

LPR2: 2-electrode, linear polarization (corrosion rate).
GALV.: 2-electrode, zero-resistance, current measurement.
POT.: 2-electrode potential measurement.

Once the measurement type has been selected, one of two
screens will present itself to the user. If galvanic or potential
measurement has been selected, a screen showing the probe I.D.
number, the UNS code, and measurement type will be shown. If
the information shown on the screen is consistent with the user’s
requirement, the “ENTER” key will accept this information and
return the user to the main function menu from which actual
measurements may be made. Should the screen show incorrect
information, the user can use the “EXIT” key to return to the main
function menu, from which the “ENTER PROBE 1.D.” function can
be re-accessed to correct the probe I.D. information.

If the user has selected either two or three-electrode linear
polarization measurement, a time cycle screen will be shown
subsequent to the measurement type screen. Unlike galvanic or
potential measurement, linear polarization is not truly instanta-
neous. A period of time is required, following the imposition of
the polarizing voltage, during which capacitive discharge takes
place at the electrode prior to the establishment of an equilib-
rium polarizing current. If insufficient time is allowed for the
establishment of the equilibrium current, the resultant corrosion
rate measurement will be falsely high. The time required for the
establishment of equilibrium will vary from system to system.

18



The time cycle screen allows the user to set a time cycle for the
linear polarization measurement between one and five minutes.
This is selectable using the “ARROW” keys, and confirmed using
the “ENTER” key. Once the time cycle is entered, the screen will
automatically display the probe I.D., the UNS code, the measure-
ment type, and the time cycle. The “ENTER” key will accept this
information, and return the user to the main function screen,
from which the user may elect to make a measurement. Should
the information prove incorrect, the user may employ the “EXIT”
key to return to the main function screen, re-access the “ENTER
PROBE I.D.” menu and correct errors in the probe I.D.

Once a probe I.D. is entered, it will be stored and can be re-
accessed at a future date directly from the list of probe I.D.’s given
on the first screen of the “SELECT PROBE I.D.” menu. The probe
I.D. will be retained until the user deletes it, or downloads the
information for that probe I.D. to a computer.

3. Delete Probe

The second option listed in the first screen of the “SELECT PROBE
[.D.” sub-menu is “DELETE PROBE”. This is a convenient alternative
for deleting unwanted or obsolete probe data from the instrument
memory. Probe data may also be deleted using the main function
“DELETE READING” (see Delete Readings, p.27). Deletion using
the “ENTER PROBE I.D.” route can be selected using the cursor,
“ARROW” keys, and the “ENTER” key. The following screen
sequence will be activated:

19



DELETE PROBE
PROBEID:
UP ARROW WHEN DONE

UP ARROW

**E WARNING ***

PROBE ID: XXXX
DELETE ALL READINGS
ENTER=YES EXIT=NO

ENTER

Y

PROBE ID: XXXX
DELETE READINGS

AUTO

PROBE ID: XXXX
UPDATING PROBE LIST

' > SELECT PROBE I.D.
' MAKE MEASUREMENT
| RECALL READINGS
' DELETE READINGS

UNS CONST. TABLE
COMMUNICATIONS
SET TIME & DATE

r

A

A

20
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The user should scan the list of probe I.D.’s to identify and
memorize the probe I.D. to be deleted, since this will be
requested. If the probe I.D. in question is not known, the user
will have the tedious task of returning to the main function
screen, scanning the probe I.D. list, and finally re-entering the
“DELETE PROBE” sequence.

Once the “DELETE PROBE” sequence is entered, the screen will
request the I.D. of the probe to be deleted. This is entered using
the numeral keys, and the “UP ARROW” key at the conclusion.

A warning screen will now appear listing the probe I.D. to be
deleted, and a request for confirmation. If the user is in doubt,
the “EXIT” key should be used, to return the user to the main
function screen without deletion of any data. Having decided
that the probe data is of no further value, use the “ENTER” key to
delete the probe data. The instrument screen will now automati-
cally sequence through a “DELETING READINGS” screen followed
by an “UPDATING PROBE LIST” screen, and finally returning the
user to the main function screen.

Once this sequence is complete, the probe data and probe I.D. are
removed from the MS1500L memory.

21



C. Make Measurement

Before any measurement can be made, a probe I.D. must be
selected. This may be done in one of two ways. If the probe is
one for which a probe I.D. and data are already stored in memory,
simply enter the “SELECT PROBE I.D.” submenu, scan the existing
probe I.D. listings, and select the appropriate probe I.D. using the
cursor, “ARROW” keys, and the “ENTER” key when the cursor is set
on the required probe I.D. The probe is then selected, and the
user will be returned to the main function menu, from which

the user may enter the “MAKE MEASUREMENT” submenu, to
measure the selected probe. Unless the instrument is switched
off, or a new probe I.D. selection is made, the probe remains
selected, and any number of measurements may be made with-
out re-selection.

If the probe to be measured is a new probe without an I.D. in
memory, the user must enter a probe I.D. (see Enter New Probe,
p. 15). Upon completion of the “ENTER NEW PROBE” sequence,
the user is automatically returned to the main function menu, the
new probe automatically has been selected, and measurements
may be made by selecting the “MAKE MEASUREMENT” submenu.
As with an existing probe, a new probe may be subjected to as
many measurement cycles as desired without re-selection,
provided the instrument is not switched off.

Once a new, or existing, probe has been selected, the make
measurement sequence may be entered from the main function
menu using the cursor, “ARROW” keys, and the “ENTER”
instruction. This will initiate the screen sequence shown on

the next page:
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PROBE ID: XXXX
UNS NUMBER: XXXXXX
MEASUREMENT: XXXXX

GALV

PROBE ID: XXXX PRESS ENTER TO START
CURRENT: X.XXXMA POT LENTER
PRESS ENTER TO SAVE

PROBE ID: XXX
TIME CYCLE X MIN.
PLEASE WAIT

PROBE ID:  XXXX

POTENTIAL: XXX.XMV LPR3 \ﬂ

PRESS ENTER TO SAVE

v

PROBE ID: XXXX
ENTER/EXIT | pROBE ID: XXXX COR RATE: XX.XX MPY
COR RATE: XX.XX MPY PIT INDEX: X.X
PRESS ENTER TO SAVE PRESS ENTER TO SAVE
\ ‘ [
# ENTER/EXIT

SELECT PROBE ID:
MAKE MEASUREMENT
RECALL READINGS
DELETE READINGS
UNS CONST TABLE
COMMUNICATIONS
SET TIME AND DATE

The first screen of the “MAKE MEASUREMENT” submenu displays
the probe ID, UNS code, and measurement type. If this is correct,
the user should use the enter key to start the measurement cycle.
If the probe ID is incorrect, the user should use the “EXIT” key to
return to the main menu and then enter the “SELECT PROBE |.D.”
submenu to select the correct probe I.D.

If the measurement type is galvanic or potential, after initiation
with the enter key, the measurement will be completed in less
than fifteen seconds. The screen showing the measurement value
will appear displaying either probe I.D. and current (expressed
milliamps to three decimal places), or the probe I.D. and poten-
tial (expressed millivolts to one decimal place). Either screen will
instruct the user to use the “ENTER” key to save the measure-
ment. If the user does not require to save the measurement, the
“EXIT” key can be used. Both the “ENTER” and the “EXIT” key will
return the user to the main function menu allowing subsequent

measurements on the same probe or selection of a new probe for
measurement.
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If the measurement type is either two or three-electrode linear
polarization, the “ENTER” will initiate the measurement time cycle
as set by the user in the “SELECT PROBE ID” sequence. During the
measurement time cycle, the screen will display the probe I.D. and
the time cycle shown in whole minutes; a request to wait is also
displayed. During the measurement cycle, the minute indicator
will flash at one second intervals, and will count down whole
minutes to zero. Since the 2-electrode measurement involves
two polarization cycles, one anodic and one cathodic, the actual
time cycle set by the user is half the total measurement time;
the user should ensure that the cycle set for a 2-electrode linear
polarization measurement is half the desired total measurement
time.

At the conclusion of the linear polarization measurement cycle,
the 3-electrode measurement will display the probe I.D. and

the corrosion rate in MPY (“MIL PER YEAR”). The two-electrode
measurement will also display the pitting index. Either screen will
instruct the user to “PRESS ENTER TO SAVE”, which will save the
measurement and return the user to the main function menu, to
make further measurements. The “EXIT” key will also return the
user to the main menu, but will not save the measurement.
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D. Recall Readings

This main function allows the user to recall all readings stored
under any probe I.D. to the instrument screen for review. As with
most functions, the precursor to use is to select the probe of
interest. This is accomplished by entering the “SELECT PROBE ID”
submenu, reviewing the list of probe I.D.’s stored, and using the
cursor coupled with the “ENTER” instruction to select the probe
and return to the main function menu.

Once the probe I.D. is selected, the “RECALL READINGS” submenu
is entered using the main function menu cursor, directed by
“ARROW” keys, and activated with the “ENTER” key. The following
screen sequence comprises the “RECALL READINGS” submenu.

iENTER

v

XXX XX/XX/XX POT XXX XX/XX/XX LPR2
POTENTIAL: = XXX mV 4 p| COR RATE: XXX.XX MPY
USE ARROWS / ENTER USE ARROWS / ENTER
upP
ARROW
ENTER ENTER
READING#
(READING 1 TO X)

A

UP ARROW WHEN DONE

The initial screen of the “RECALL READINGS” submenu shows the
last reading number, date, and measurement type sequentially

on the top line. The reading number is merely the total number
of readings stored, which is also the number of the most recent
reading stored. The date is shown in the European form of day/
month/year. The next line shows the measured value, which may
be millivolts, milliamps, or corrosion rate depending on the
measurement type. If the measurement type is 2-electrode linear
polarization, a third line will show a dimensionless number, the
so-called pitting index.
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The last line is an instruction to use either the “ARROW” keys

or the “ENTER” key. The “ARROW” keys allow the user to scroll
backwards (“DOWN ARROW”) and forwards (“UP ARROW”),
sequentially, through the stored readings for the selected probe.
In instances where several hundred readings are stored, and the
user wishes to access a specific reading, use of “ARROW” keys and
scrolling can prove tedious. In such a case, the user should use
the “ENTER” key which will call up the reading number screen.
The user can insert the reading number of specific interest and
use the “UP ARROW” to recall the initial screen at the reading
number selected; scrolling either side of the selected reading
number can be resumed using the “ARROW” keys. The user can,
at any time, return to the main function menu using the “EXIT”
key.
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E. Delete Readings

This function is more selective than the “Delete Probe” function
(p.19) found in the “SELECT PROBE I.D.” submenu. Using the
“Delete Readings” function, it is possible to selectively delete
individual readings stored under any given probe I.D.

Having selected a probe the user may select the “Delete Readings”
function using the cursor and “ENTER” key on the main function
screen. The following screen sequence illustrates the use of the
“Delete Readings” sub-menus:

SELECT PROBE ID:
MAKE MEASUREMENT
RECALL READINGS
DELETE READINGS
UNS CONST. TABLE
COMMUNICATONS

SET TIME AND DATE UP ARROW

‘
i
|| _ENTER o pe| ETE READINGS
!
|
!
|
‘

DELETE STARTS X

UP ARROW WHEN DONE

DELETE READINGS
#X DD /MM /YR

AUTOMATIC UP ARROW WHEM DONE
UP ARROW
DELETE READINGS DELETE READINGS
#X DD/ MM/ YR ENTER #X DD/ MM / YR
#Y DD /MM /YR ———— #Y DD /MM /YR
PLEASE WAIT ENTER TO DELETE

The first screen of the sub-menu requires the user to insert the
reading number at which the deletion process should start. For
example, if the user wishes to delete the first 50 readings, the
number “1” will be the reading number at which deletion starts.
Once the appropriate number is entered, the ‘UP ARROW’ will
take the user to the new sub-menu screen.

27



This second screen displays the reading number at which dele-
tion is to start, together with the date of this reading displayed in
European format. The screen also requests the process is to stop.
Once the number of the final reading to be deleted is entered, the
‘UP ARROW’ will then display an action confirmation screen.

This action confirmation screen shows the user both the initial and
final ending number in the deletion sequence, together with the
date of each reading. If the user wishes to proceed with deletion,
the enter key is used and, after a short waiting period, the dele-
tion is complete. At this point, the screen automatically reverts

to the main function screen and, the selected readings have been
deleted. Should the user not wish to proceed with deletion, the
user should press the “EXIT” key, returning automatically to the
main function screen without deletion of any readings.
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F. UNS Constant Table

1. General

As explained in the “ENTER NEW PROBE” section, the UNS alloy
code is used exclusively for reference in the case of 3-electrode
linear polarization measurement, galvanic measure-ments, and
potential measurements. It merely allows the user, through the
probe I.D. listings in the “SELECT PROBE ID” submenu, to have a
permanent record of the type of alloy used for the electrodes of a
specific probe.

The exception to this function is when the measurement type is

a 2-electrode linear polarization measurement. In this case, the
UNS code will alter the constant of proportionality, used in the
corrosion rate calculation. This is necessary since each alloy/
metal has a unique factor in the equation relating polarizing cur-
rent to corrosion rate. This factor is the equivalent weight divided
by the density. In conventional 3-electrode measurements, this
uniqueness is accounted for by varying the surface area of the
working electrode from alloy to alloy to account for these varia-
tions. Essentially, the surface area of the working becomes part
of the instrument constant. However, the major manufacturer

of electrodes for the two-electrode linear polarization measure-
ment uses a constant electrode surface area, irrespective of

alloy. Consequently, when making a two-electrode polarization
measurement, an additional factor must be incorporated into the
instrument constant to account for the variable density and equiv-
alent weights. Precise derivation of the “alloy constant” is shown
in Appendix 1 of this manual, as is a table of common alloys their
UNS code, and the appropriate alloy constant.

The “UNS CONST TABLE” contains a listing of 45 of the most
common alloys, which is used as a look-up table, automatically
applying an appropriate alloy constant to each two-electrode
linear polarization measurement. The “UNS CONST TABLE” func-
tion is accessible to the user through the main function menu, to
allow additions or deletions from the UNS/alloy constant table.
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The table has a maximum capacity of fifty listings. Attempts to
add more than the total of fifty, either directly through the “UNS
CONST TABLE” or through the “SELECT PROBE ID” function will
overwrite the initial listings in the table. To avoid elimination of
regularly used alloy constants, the user should delete constants
and UNS codes that are rarely used before adding new ones,
once a total listing of fifty has been reached.

2. Addition / Deletion of UNS Codes

Access to the “UNS CONST TABLE” function is achieved, as with all
main functions, by use of cursor “ARROW” keys, and “ENTER” key
in the main function menu. Unlike most functions, entry into the
“UNS CONST TABLE” does not have to be preceded by a probe I.D.

selection. This submenu sequence for this function is illustrated

below:

h 4
DELETE UNS NO.
UNS ID:
| USE ARROW KEYS

ENTER INITIAL
LETTER

DELETE UNS NO.
UNS ID: LXXXXX
UP ARROW WHEMN DONE

UP ARROW

h 4
WARNING
UNS ID: LXXXXX
DELETE UNS/CONST?
ENTER=YES EXIT=NOC

P ENTER NEW UNS
DELETE UNS

h 4

SELECT PROBE ID:
MAKE MEASUREMENT
RECALL READINGS
DELETE READINGS

UNS CONST. TABLE
COMMUNICATONS

SET TIME AND DATE
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[uns No.
| USE ARROW KEYS

| ENTER INITIAL
v LETTER

UNS NO. LXXXXX

UP ARROW WHEMN DONE

UP ARROW

Y

UNS NO. LXOXX

ALLOY CONST: X.X

. ENTER ALLOY CONST.

ENTER
k4
UNS NO. LXXXXX
ALLOY CONST: X.X
ENTER TO ACCEPT



The first screen of the “UNS CONST TABLE” submenu offers two
options, “ENTER NEW UNS” and “DELETE UNS”. Either of these
options can be selected using the cursor in conjunction with the
“ARROW” keys, followed by the “ENTER” key.

If the “ENTER NEW UNS” option is selected, the second screen
will request the UNS number. The user should select the initial
letter of the UNS number, using the “ARROW” keys to scroll, and
the “ENTER” key. This will activate the third screen that allows the
user to enter the five digits using the keyboard, and confirm entry
with the “UP ARROW” key. The forth screen is now activated, and
the user should enter the alloy constant (one integer and first
decimal) followed by the “ENTER” key confirmation. This will
activate a final screen showing the UNS number and alloy code,
which the user should confirm using the “ENTER” key. At this
point, the user may also use the “EXIT” key if the UNS number or
alloy code is incorrect. Either command will return the user to the
main function screen for further measurements, or to re-access
the “UNS CONST TABLE” function to enter correct codings.

If the “DELETE UNS” option is selected, the second screen of the
sequence will request the UNS ID. The user should use the
“ARROW” key to scroll to the appropriate initial letter and the
“ENTER” key to confirm the selection. This will activate the
second screen, allowing the user to enter the remaining five digits
using the keyboard, and finally confirming the entry with the “UP
ARROW” key. This will activate the final screen of the sequence
showing the UNS code and requesting an “ENTER” instruction

to delete, or an “EXIT” instruction to abort deletion. Either
instruction will return the user to the main function screen for
further measurements or data input.
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G. Communications

The MS1500L Data Logger has the ability to store readings as they
are taken. These readings can later be transferred to your PC via
serial port or USB port. To transfer data to a PC it is necessary to
install the Corrosion Data Management Software.

Installing the Software
To run the Corrosion Data Management Software, you need a PC
that meets the following requirements:

* Pentium® class processor

¢ Windows® 95 or higher operating system

e 16 MB of RAM

e 10 MB of available hard-disk space

¢ VGA monitor with 800 600 or greater resolution
e Mouse or pointing device recommended

¢ Available 9-pin serial port or USB port

e CD-ROM drive for software installation

To install the Corrosion Data Management Software:

1. Insert the setup disk provided in your accessory Kkit.

2. You will be prompted to close any open programs. After
you have done so, click OK to continue.

'f:'.- Metal Samples CDMS Setup

% Welcome ko the Metal Samples COMS instalation program.
|._

Setup cannot instal system files or update shared files if they are inuse.
guepm,mmmmmummwwhmmmw
FURINING.

||T|| Ext Setup
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3. Click the install button to begin installation. Note, it is
recommended that you install the software in the default
directory.

4. After clicking the install button, the software will be
installed on your PC.

5. When the software installation is complete you should
remove the setup disk, then reboot your computer.
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Instrument Download Center

The Instrument Download Center is a simple tool for retrieving
data from Metal Samples ER and LPR data logger instruments.

[ Metal S amples - COMS Masn Menu I E:;:F-!j
|§ Metal Samples L
=—— Corrosion Moniforing Systems _
{+] Data M ?; |
Main Menu
’ Q = |. \J ‘ {‘\ ;é
ARG
Instrument Data LPRAlloy  Corrosion \;,
Download Analysis Multiplier Coupon @
Center Worksheet Worksheet Sy
e e T
To download data from an instrument:

Connect the instrument to an available PC serial port or
USB port (see page 3.)

Turn the MS1500L on.

Run the Corrosion Data Management Software

Open the Instrument Download Center

Select the serial port and instrument

Click the Download button (ensure that Part Status toggles
to “On”).

From the main menu of the instrument, go to the Select
Probe I.D. menu and select the probe data you wish to
download.

From the main menu of the instrument, go to the
Communications menu and select Computer Upload.

Data will begin to transfer from the instrument to the PC, and will

appear

in the data window of the Instrument Download Center as

shown above. If the data appears garbled, the wrong instrument

type ha

s been selected. Select another instrument type and try

again. If data does not appear in the data window at all, verify

that:

34



e The instrument is connected to a valid serial or USB port

e All cables are securely connected

e The message “Port Status: On” appears in the status bar

e There are no errors on the instrument

e |f using a USB adapter, ensure that the device drivers have
been installed.

Selecting a Serial Port

Use the Serial Port selection box to select the port to which the
instrument is connected. If the COM port number is unknown, it
can be found in Windows Device Manager under “Ports (COM &
LPT)”.

Selecting an Instrument

Use the Instrument option box to select the model of Metal
Samples instrument being downloaded. This sets the appropriate
communication parameters, which will be displayed in the status
bar at the bottom of the window (“9600,N,8,1” for an MS1500,
“2400,N,8,1” for an MS3500).

Downloading Data
To toggle the selected port on and off, click the Download button.
Toggling the port on and off will also clear the data window.

Once a valid serial port and instrument have been selected, click
the Download button to turn the port on and enable the com-
puter to receive data. If a valid serial port has been selected, the
status bar at the bottom of the window will display the message
“Port Status: On”. If an invalid serial port has been selected, an
error message will appear, and the status bar will display the mes-
sage “Port Status: Off”. If this happens, another serial port should
be selected.
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Saving Data

To save the data in the data window, click the Save button. The
data is comma-delimited ASCII text. It can be saved to a standard
text (.txt) file, or it can be saved to a comma-separated values
(.csv) file, which greatly simplifies the process of importing the
data into a spreadsheet program such as Excel®.

Printing Data

To print the contents of the data window, click the Print button.
A print dialog box will be displayed to allow printer selection and
setup.

Charting Data

To chart the contents of the data window, click the Chart Data
button. If the data has not yet been saved, the user will be
prompted to do so before the charting process begins. For more
information on charting data, see the Data Analysis section.

Data Analysis

The Data Analysis utility is a convenient tool for charting data from
Metal Samples ER and LPR data logger instruments. The Data
Analysis utility can be opened from the Main Menu, or it can be
opened directly from the Instrument Download Center.

If the Data Analysis utility is opened from the Instrument Down-
load Center, the contents of the data window will be loaded into
the chart. However, if the Data Analysis utility is opened directly
from the Main Menu, a valid data file must be loaded. The Select
File box will open to allow selection of a data file.
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Loading a Data File

After selecting a data file (or clicking the Chart Data button from
the Instrument Download Center) a status window will display the
progress of the file being opened, along with the Instrument Type,
Probe Type, and Probe ID for the data file.

## Dpening Data File

Progress:

Instrument Type: MS1500E

Probe Type: Wire Loop
Probe ID: 1000

_canceL |

Data Table

After a file has been successfully loaded, the data will be displayed
in the Data Table for review. By default, all data points will be
included in the chart. However, data points can be turned off,

or excluded, from the chart. If the “Excluded” flag appears in the
status column for a data point, that data point will not appear in
the chart. To toggle the exclude/include status of a data point,
double-click the data point, or select the data point and click
Exclude/Include in the Options menu.

E=Data Table M= E3
Dptions  Help
READING # METAL LOSS [mils)| DATE [dd/mm/py) | PROBE ID [PROBE TvFE [sTaTUS =]
1 2040 127312001 1000 Wire Loop |
2 2000 137372001 1000 Wie Loop
3 2040 14/3/2001 1000 Viiie Loop
4 1.980 15/3/2001 1000 Wit Loop
5 2000 16/3/2001 1000 Wite Loop
B 2040 17/3/2001 1000 Wi Loop
7 2080 184372000 1000 Wie Loop
8 20%0 19/3/2001 1000 i Loop
g 2200 20/3/2001 1000 ‘Wie Loop
10 2290 21/2/2001 1000 Wie Loop
1 2290 22/3/2001 1000 Wite Loop Exchided
12 2290 23/3/2001 1000 Wire Loop Exchided
13 2510 24/3/2001 1000 Wie Loop Exchided |
4 I »
Chart Data EXIT

Printing Data

The data table can be printed by clicking Print in the Options
menu. A print dialog box will be displayed to allow printer
selection and setup.
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Creating A Chart

To chart the selected data, click the Chart Data button, or select
Chart Data from the Options menu. The chart will be displayed in
a new window.

E
= e

Prbes K0 1550 v e Wi Lnog

Printing a Chart

A chart can be printed using the Print Chart option in the File
menu. A print dialog box will be displayed to allow printer selec-
tion and setup.

Exporting a Chart

A chart can be exported to other applications using the Copy Chart
option in the File menu. This will copy both the chart and the raw
data to the Windows® Clipboard. The chart can then be inserted
into other applications using the Paste function. Note: In some
applications, using the Paste function will insert the raw data
instead of the chart. In this case, use the Paste Special function,
then select Picture to insert the chart.

Chart Tools
e Statistical Data
The Statistical Data tab at the bottom of the Data Chart
window will display a page with statistical information
about the chart data. If the Statistical Data page is visible,
this information can be printed by clicking Print Statistical
Data in the File menu.
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¢ Finding A Data Points Value
While viewing the chart, the value of any data point can
be determined by simply clicking it. The value will be
displayed in the charts tool-tip box (a small text box that
is displayed near the mouse pointer). If the tool-tip box
does not appear immediately after clicking the data point,
hold the mouse pointer stationary over the chart back
ground for a moment.

¢ The Tools Menu
The Tools menu contains a collection of utilities for viewing
and manipulating the chart. The Tools menu can be
accessed by clicking Tools on the menu bar, or by right-
clicking anywhere on the chart.

Hide Data Markers Ctl+D
Show Mean Value Clrl+d
Show Trend Line Ctl+T
Title/Eoatnate Setup Chil+F
Plot Setup Ciil+0
Data Series Color Chrl+L
Zoom In F5
Zoom Qut F6
Calculate Corrosion Rate F7

o Data Markers
Show Data Markers toggles the data markers on and off.

O Mean Value
Show Mean Value toggles the mean value line on and off.

O Trend Line
Show Trend Line toggles the trend line on and off.
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o Title/Footnote Setup
Title/Footnote Setup displays a window that allows the
chart title and footnotes to be toggled on and off, and to
be modified.

O Plot Setup
Plot Setup displays a window that allows configuration of
Y-axis scaling, and of the chart type.

The Y-axis can be scaled to default values by checking

the Auto Scaling option box. The Y-axis can be scaled to
manual values by un-checking the Auto Scaling box, then
entering the desired values in the Minimum and Maximum
fields.

The chart type can be set to Line Chart, Bar Chart, or Area
Chart by selecting the appropriate button in the Chart Type
box. The default chart type is Line Chart.

o Data Series Color
Data Series Color displays a color selection box, which
allows the user to select the brush color for the plot line.
The default color for the plot line is Blue.

O Zoom In
Zoom In allows a region of the chart to be enlarged so
that it may be viewed in greater detail. To enlarge a region
of the chart, click on the two data points that define the
left and right boundaries of the region.

In zoom mode, the mouse pointer will change to a cross-
hair. When zoom mode ends, the mouse pointer will re

turn to its normal state.

To cancel zoom mode, click Cancel Zoom In from the Tools
menu, or simply press the Esc key.
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O Zoom Out
Zoom Out restores the initial view of the chart, which dis
plays the full data set.

o Calculate Corrosion Rate
If the chart contains ER data, the Calculate Corrosion Rate
option will become available under the Tools menu. This
option allows the corrosion rate to be calculated between
any two data points on the chart. To calculate the corro-
sion rate click Calculate Corrosion Rate, then click two data
points. The corrosion rate between those two data points
will be displayed.

In calculate mode, the mouse pointer will change to an
arrow/question mark. When calculate mode ends, the

mouse pointer will return to its normal state.

To cancel a calculation, click Cancel Calculate from the
Tools menu, or simply press the Esc key.
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lll. Theory of Operation

Overview of Linear Polarization

When a metal/alloy electrode is immersed in an electrolytically
conducting liquid of sufficient oxidizing power, it will corrode by
an electrochemical mechanism. This process involves two, simul-
taneous, complementary reactions.

At anodic sites, metal will pass from the solid surface into the
adjacent solution and, in so doing, leave a surplus of electrons at
the metal surface. The excess electrons will flow to nearby sites,
designated cathodic sites, at which they will be consumed by
oxidizing species from the corrosive liquid. A simple example,

of iron dissolving in acidic solution, is illustrated below:

SOLID METAL CORROSIVE SOLUTION

e L e
lcorr | 2€
CATHODIC H*
SITE HT’HZ
Fe — Fe*+2¢e
OH" + 26 » H,

42



This electron flow, or movement of electric charge, constitutes

an electric current loz. Since the flow of electric current in such

a situation can be equated to loss of metal mass, or volume, by
Faradays Laws, I.oz is @ measure of corrosion rate. The relationship
of Ior to corrosion rate is shown in Equation 1:

Czlngxth%xD ................. (1)

C = corrosion rate (MPY)

lcor = corrosion current (mA)

A = surface area of metal/alloy (cm?)

= no. of second in 1 year (31,536,000)

= Faraday’s constant (96,494 coulombs. (gm.equ)?)
Equivalent weight of metal (gm.(g.equ.)?)
density of metal (gm.cm?3)

= conversion factor, centimeters to mils. (393.7)

oo mmT~+

Equation 1 reduces to:

c='% X % X 128.67 oo, (2)

Since E and d are known for all metals, and A can be fixed, a
measurement of Iz would allow corrosion rate to be determined.
Unfortunately, direct measurement of | is not possible, since
anodic and cathodic sites on a metal surface are continually
shifting within a continuously conducting surface.

Indirect measurement of I, is possible. This can be achieved by
applying a small potential shift (AE) to a corroding metal surface,
and measuring the current (Al) required to maintain this potential
displacement. The value AE/Al, commonly called the polarization
resistance, is inversely proportional to loz. This relationship is
embodied in the Stern-Geary equation:
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1 AT (b, +15. 0
- I (3)
R, NME b, b, ot

Rp= polarization resistance (ohms)

b, = anodic rate constant (mV. decade )

b.= cathodic rate constant (mV. decade %)

Rearrangement of equation 3 gives:

_ A by (4)

23 (b, + b)) AE

COR

Substituting from 4 into 2:

Al (b, 1b, |
C = o 15 ) cE 012867 . (5)
234. E@B, +1b, ) d

Practical measurement instruments fix the polarizing voltage at
some small value, for which equation 3 holds true. This is usually
10mV or 20mV.

The ratio (bas | bc | ) / (ba+ | bc |) is assumed to be constant.
Although this is not strictly true, changes in ba and bc are largely
canceled out in the ratio. Commercial instruments generally
absorb this ratio into and empirical “constant”, which constitutes
the average constant of proportionality derived from a large
number of E/ | measurements made with corresponding weight
loss data.

Variations in E/d values are practically accounted for by varia-
tions in the surface area of the test specimen, or by programming
commercial instruments with an “alloy constant” for each possible
E/d value; this latter process is explained in Appendix 1, as is the
derivation of the equivalent weight of an alloy.
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A final factor influencing any practical measurement, is the capac-
itive effect that is produced by polarizing a metal surface. Upon
initial application of the polarizing voltage (AE), the resulting cur-
rent flow (Al) is a combination of the true polarizing current (Al),
and the charging current (Al.) used in charging the double-layer
“capacitor” at the metal/solution interface. This capacitive cur-
rent discharges after a finite time leaving only the residual polariz-
ing current that is the true measured value. This effect is illustrat-
ed below:

AT’ POLARIZING CURRENT

The true value of the polarizing current is the equilibrium value
(Al), that is established after a time interval T.. This time lag will
vary, depending on the specific characteristics of the metal/
environment system, between approximately 30 seconds and
several hours. Typically, system exhibiting high corrosion rate with
little film formation have short time cycles (T.), whereas low corro-
sion rate systems showing strong film formation have longer time
cycles. Commercially available instruments provide a variable
measurement time cycle to account for this phenomenon. Since
the decay characteristic is asymptotic, even systems with extreme
“capacitative inertia” will closely approach equilibrium within 15
minutes.
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Two-electrode Corrosion Rate Measurement

This technique is the simplest of all LPR corrosion rate measure-
ments. This utilizes a sensor with two identical electrodes, made
from the metal/alloy of interest. The notional, equivalent electric
circuit, is illustrated below:

Ro AE Ro
RS
(T %‘ NV
- Al -
Ce Ce

R = Polarization Resistance
Rs= Solution Resistance
C.= Electrode Capacitance

20mV are applied between the test and auxiliary electrodes, for
the predetermined (user-selectable) time cycle, and the polarizing
current at the end of the cycle (I;) is stored. The applied potential
is then automatically reversed, and the equilibrium polarizing
current (I) value is again stored. The average value of the
polarizing current in the forward and reverse polarizations is

then automatically used to calculate, and display corrosion rate,
directly as MPY. This manipulation is based on equation 5, p.44.

Since no instrumental method is used to account for variations in

E/d from metal to metal, this is preprogrammed into the measure-
ment by menu selection of alloy constant.
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An additional factor that is displayed is the, so called, pitting index.
This is, in fact, the ratio of the forward and reverse polarizing
currents (I¢/1z). Some manufacturers claim that this value gives
some indication of the pitting characteristics of the system. Metal
Samples cautions the user to interpret the “pitting index” with
considerable skepticism. This value merely indicates some form
of asymmetry between the two electrodes, of which pitting is

on manifestation of many. Some other possible sources of
asymmetric polarization are non-uniform flow characteristics or
scale deposition, small differences in electrode composition or
presence of surface inclusions, and variations in electrode surface
roughness.

Although the two-electrode measurement is electronically simple,
and allows the use of comparatively small sensors, it does have a
serious limitation. No means is incorporated into this technique
to allow for solution resistance errors. For solutions of significant
resistance, the polarizing voltage AE is partially “dropped” across
the solution resistance R;. Consequently, the amount of polarizing
voltage used to measure the polarization resistance is lower than
that anticipated. This can be quantified as follows:

AE = ARy - AIRg e (6)

In effect, the true corrosion rate is under estimated by a percentage
given by:

PERCENT ERROR = (1 - R¢/R;) x 100

The “IR-Drop Error” in this technique is directly proportional to
solution resistance and to corrosion rate. It is difficult to set ab-
solute limits on applicability, however, fluids with a solution resis-
tance of more than 50-100Q2 cm™ are likely to produce unaccept-
able errors. The technique should be confined to such fluids such
as brines, sea-water, cooling waters, and electrolyte solutions with a
concentration of 0.1M and higher.
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Three-electrode Corrosion Rate Measurement
The three-electrode method uses a true potentiostatic circuit to
shift the potential of a test electrode 10mV. from the corrosion po-

tential (open-circuit, “equilibrium” potential). Such a circuit may
be notionally represented as shown below:

10 mV
el
) o Iy

N
"
Wi

ML V
3 >
< ©
Y— = >
& <
(R) ) (A)

When a measurement is made, the instrument will initially null
any residual potential difference between the reference electrode
and the test electrode. After which, current will flow from the
auxiliary electrode onto the test electrode. The flow of current,
between the auxiliary electrode and the test electrode, will in-
crease until the test electrode potential is shifted 10 mV with
respect to the reference electrode. The current (Al) required to
sustain the 10 mV potential shift is used to compute R,, which in
turn is used to provide a direct read out of corrosion rate.
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This technique does not require the individual programming of al-
loy constants to allow for variations in E/d from alloy to alloy. This
variation is accounted for by varying the surface of electrodes in
direct proportion to E/d from alloy to alloy, so that compensation
is automatic.

The major advantage of the three-electrode LPR technique is that
it considerably lowers the effect of solution resistance errors. This
is achieved by measuring the polarizing voltage, as the potential
shift of the working electrode relative to a reference electrode, in
a high impedance circuit. Negligible current flows in this potential
measuring circuit and, IR-drop errors are virtually eliminated.

Some residual IR-drop error does occur in highly resistive solu-
tions, due to the spreading of the current field generated by

the flow of current between the test electrode and the auxiliary
electrode. Excessive current spread will cause the field to impinge
on the reference electrode, which will introduce an IR-drop error.
The extent of this error is largely a function of electrode geometry
as illustrated on the next page.

As can be seen, the “field effect” error is greatest with a triangle
electrode configuration, less so with a linear electrode configura-
tion, and almost non-existent with a concentric ring arrangement.
An appropriate choice of electrode geometry, will allow measure-
ments to be made in solutions with resistivities of 1000 - 2000
Q.cm™. While this technique is a significant improvement on the
two-electrode measurement, it will give erroneous information in
discontinuous electrolytes, and poorly conducting fluids such as
distilled water. In these latter cases, as with gases, the user must
resort to electric resistance corrosion measurement sensors.
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In making the three electrode LPR measurement, the MS1500L
uses a high impedance potential measuring circuit. Advantage is
taken of this circuitry to provide the user with a means of directly
measuring both redox and corrosion potentials. The uses of such
information in corrosion diagnostics are many and various, and

a full discussion of this topic is beyond the scope of this manual.
However, a few examples are given below, to provide the reader
with some insight into the versatility of potential measurements.

Application Criteria of Assessment Electrode System

Cathodic -850mV vs. Cu/CuSO, or Cu/CuSO, or Ag/AgCl

Protection Negative Swing of 200mV | Reference vs. Protected
Structure

Oxygen Ingress | Positive Potential Swing Platinized Niobium vs.
Ag/AgCl Reference

Actice-Passive | Passivation - Positive Ag/AgCl Reference vs.
Transitions Potential Swing Activation | Alloy of Constructiom
- Negative Potential Swing
Pitting Rapid Potential Transients | Identical Electrodes of
with Time the Constructional Alloy

With an appropriate choice of electrode combinations, potential
measurements will provide extensive information on file forma-
tion and breakdown, localized attack, and indicate the presence of
the various oxidizing species necessary for corrosive attack.
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IV. Testing the MS1500L with the LPR
Meter Prover

An LPR Meter Prover is provided to allow routine checks of
the MS1500L instrument. The LPR Meter Prover simulates a
3-electrode LPR probe at a fixed value which is printed on the
Meter Prover label (as shown below.)

&= MetalSamples

-— Corrosion Monitoring Systems

LPR Meter Prover

Reading:

‘ 10 mpy +/- 1 mpy ’
(LPR3 Settings)

To test the MS1500L with the Meter Prover:

1) Enter a new Probe ID in the MS1500L menu

with the following settings: ]
* Probe ID: Enter any ID number that -
does not conflict with probe
ID’s in use. E%E
e Probe Type: LPR3A 000
e UNS Number: G10100 000

e Cycle Time: 1 Minute

See “ENTER NEW PROBE” on page 15 of the
user’s manual for detailed instructions.
Note: This Probe ID can be used for future
checks with the Meter Prover.

2) Connect the LPR Meter Prover to the MS1500L
probe connector as shown to the right.

3) Perform a measurement by selecting “MAKE MEASUREMENT”
from the main menu (see page 22 of the user’s manual.)
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4) Allow the measurement to finish. The measured value should
match the value on the Meter Prover label, and should be
within the printed tolerance. If the reading is out of tolerance
then further troubleshooting may be required.

It is important to remember that the LPR Meter Prover simulates

a 3-electrode probe. If the 2-electrode setting is used to measure
the Meter Prover, the results will not match the printed value.
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V. Appendices

Appendix 1 - Derivation of Alloy Constant

The variation of the Stern Geary equation, relating the corrosion
current icr, to the polarization resistance AE/Al is given by:

Al B,B,

icor = e U L LRI T (1)

2.3 AE (B,+B,)

which reduces to:

|cor

AE

Al

B,+B.

K

icor = KAl e, (2)

current due to corrosion (amps)
applied polarizing voltage (volts)
measured polarizing current (amps)
rate constants (volts/decade)
constant (dimensionless)

To convert the polarizing current to the conventional MPY
(“MILS PER YEAR”) units of corrosion, Faraday’s laws are applied

as follows:

C = icor X S
AxF
_ Al.kx S
AxF

- Alk

A
S =
F =
A =
E =
d =
C =

E 1000
. 3

9 X 252 3)
E 1000
. 4

X9 52 (4)
E

L X — (5)

number of seconds in one year

Faraday’s constant (coulombs)

working electrode surface area in cm?
equivalent weight of corroding metal (gms)
density of corroding metal (gms. cm)
corrosion rate (mpy)
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Consequently, when the instrument calculates the corrosion rate
(mpy) from the measured polarizing current (Al), a means needs
to be found whereby the instrument can “know” the appropriate
value of E/d, and perform the correct calculation of corrosion rate.
This is achieved in the conventional, three-electrode LPR measure-
ment by varying the surface area of working electrode in propor-
tion to the E/d value of the metal/alloy in question, thus avoiding
the need to program special correction factors into the instrument
for each and every alloy.

Unfortunately, the major producer of the two-electrode probe
uses a constant surface area for the working electrode, irrespec-
tive of the metal/alloy under examination. Thus a correction
factor has to be applied for each metal/alloy under consideration.
This is, in fact, the alloy constant used for two-electrode corrosion
rate measurements in the MS1500L unit. The basic formula for
derivation of the correction factor is:

A, =  0.55xE
d 6
A, = alloy constant
E = equivalent weight of metal/alloy in question (gms)
d = density of alloy in question (gms. cm3)

For pure metals, if the appropriate alloy constant does not appear
in the MS1500L memory already, the user can apply equation 6
to calculate, and program, the appropriate alloy constant into the
instrument memory.

Difficulties arise when trying to work out the equivalent weight of
alloys. This is approached by use of a weighted average, assum-
ing all major metallic constituents corrode in proportion to their
weight percent for the alloy in question.
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In general, metallic constituents present in amounts smaller than
1% are disregarded for the purposes of this calculation. An exam-
ple of this is given below for AISI 302 Stainless Steel.

Element Percent Eq. Wt. Eq. Wt. x Percent
Chromium 18 17.34 3.12
Nickel 9 29.35 2.64
Iron 73 27.92 20.39
Alloy Eg. Weight = 26.15
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UNS Constant Table

The following lists many of the common constructional metals/
alloys with their appropriate alloy constants. All of these values
are already programmed into the MS1500L memory. Additional
alloy constants can be added by the user, applying the calculation
principles outlined previously, and with reference to the Table of
Equivalent Weights on p. 59.

Alloy  Alternate
UNS# Const. Designation
F12101 1.0 -
F13502 1.0 -
G10100 1.0 AISI 1010
G10180 1.0 AISI 1018
G10200 1.0 AISI 1020
K03504 1.0 ASTM A105
K03006 1.0 ASTM A106
K02504 1.0 ASTM A53
K03011 1.0 ASTM A350LF2
K01800 1.0 ASTM A516
G41300 1.0 AISI 4130
K41545 1.0 ASTM A199
$50400 1.0 ASTM A199 (T9)
S30400 1.0 AISI 304
S30403 1.0 AISI 304L
S31600 1.0 AlISI 316
$31603 1.0 AISI 316L
$32100 1.0 AlISI 321
S41000 1.0 AlSI 410
S43000 1.0 AISI 430
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Major Constituents
(or common names)

Gray Cast Iron

Gray Cast Iron

0.1% Carbon Steel
0.18% Carbon Steel
0.20% Carbon Steel
0.35% Carbon Steel
0.3% Carbon Steel
0.25% Carbon Steel
0.3% Carbon Steel
0.18% Carbon Steel
1% Cr 0.2% Mo Steel
5% Cr 0.5% Mo. Steel
9% Cr 1.0% Mo. Steel
18% Cr 8% Ni S.S.

18% Cr 8% Ni (Low Carbon) S.S.
18/Cr 10/Ni/ 3/Mo S.S.
“(Low Carbon) S.S.

Ti Stabilized 18/8 S.S.
12% Cr. S.S.

17% Cr.S.S.



Alloy  Alternate Major Constituents

UNS# Const. Designation (or common names)
$31200 1.0 ASTM A182 26 Cr 6 Ni Duplex SS
$31803 1.0 ASTM A276 22 Cr 5 Ni 3 Mo. Duplex S.S.
C11000 2.0 AMS 4500 99.90 Copper

C26000 1.8 AMS 4505 70-30 Brass

C28000 1.8 ASME SB111 Muntz Metal (60% Cu)
C23000 1.9 ASME B16.22 85-15 Brass

C63000 1.9 AMS 4640 Aluminum Bronze
C68700 1.9 ASME SB111 Aluminum Brass (Arsenical)
C44300 1.8 ASME B111 Admiralty Brass
C70690 1.9 ASTM F96 90-10 Copper Nickel
C71590 1.6 ASTM F96 70-30 Copper Nickel
N04400 1.2 AMS 4544 Monel 400

N08825 1.0 ASME B163 Incoloy 825

N06600 1.0 AMS 5540 Inconel 600

N06625 1.0 AMS 5401 Inconel 625

N10001 1.0 AMS 5396 Hastelloy B

N10002 1.0 AMS 5388 Hastelloy C

N10276 1.0 ASME B366 Hastelloy C-276
N02201 0.9 AMS 5553 Nickel 201

N08904 1.0 ASME B625 23-1-4-25 Cr-Cu-Mo-Ni
713001 1.3 ASTM B6 99.990 Zinc

R05200 0.6 ASTM B364/365 Tantalum

R50250 0.7 ASTM F67 Titanium

R60701 1.0 ASTM B493 Zirconium

A96061 0.9 AA6061 Aluminum
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Table of Equivalent Weights

Name Symbol Atomic Wt.
Actinium Ac (227)
Aluminum Al 26.98
Americium Am 243
Antimony Sb 121.76
Arsenic As 74.92
Barium Ba 137.36
Berkelium Bk (247)
Beryllium Be 9.013
Bismuth Bi 208.99
Cadmium Cd 112.41
Calcium Ca 40.08
Cerium Ce 140.13
Cesium Cs 132.91
Chromium Cr 52.01
Cobalt Co 58.94
Columbium, See Niobium

Copper Cu 63.54
Curium Cm (247)
Dysprosium Dy 162.51
Erbium Er 167.27
Europium Eu 152.0
Francium Fr 223
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Valence

Equivalent Wt.

N W L W NN WS

N W W W -

8.99

40.58
24.97
68.68

4.51
69.66
56.20
20.04
46.71
132.91
17.34
29.47

63.54
82.33
54.17
55.75
76.0
223



Table of Equivalent Weights (continued)

Name

Gadolinium
Gallium
Germanium
Gold, Arum
Hafnium
Holmium
Indium
Iridium

Iron
Lanthanum
Lead,
Plumbum
Lithium
Lutetium
Magnesium
Manganese
Mercury

Molybdenum

Neodymium
Neptunium
Nickel
Niobium

(Columbium)

Osmium
Palladium
Platinum
Plutonium
Potassium

Symbol Atomic Wt.
Gd 157.26
Ga 69.72
Ge 72.60
Au 197.0
Hf 178.50
Ho 164.94
In 114.82
Ir 192.2
Fe 55.85
La 138.92
Pb 207.21
Li 6.94
Lu 174.99
Mg 24.32
Mn 54.94
Hg 200.61
Mo 95.95
Nd 144.27
Np (237)
Ni 58.71
Nb 92.91
Os 190.2
Pd 106.4
Pt 195.09
Pu (244)
K 39.1
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Valence

Equivalent Wt.

3

W NN W W wWw bk wbsnN

N U1 W N P NN WELEN

= U0 NN 0 U

52.42
34.85
18.15
65.66
44.62
54.98
38.27
64.06
27.92
46.30

103.6
6.94
58.33
12.16
27.47
200.6
47.97
48.09
47.40
29.35

18.58
23.77
53.2
97.55
48.80
39.1



Table of Equivalent Weights (continued)

Name

Praserodymium Pr

Promethium
Radium
Rhenium
Rhodium
Rubidium
Ruthenium
Samarium
Scandium
Selenium
Silver
Sodium
Strontium
Tantalum
Technetium
Tellurium
Terbium
Thallium
Thorium
Thulium
Tin, Stannum
Titanium
Tungsten
Uranium
Vanadium
Ytterbium

Symbol Atomic Wt.
140.92
Pm (145)
Ra 226
Re 186.22
Rh 102.91
Rb 85.48
Ru 101.1
Sm 150.35
Sc 44.96
Se 78.96
Ag 107.87
Na 22.99
Sr 87.23
Ta 180.95
Tc (97)
Te 127.61
Th 158.93
Tl 204.39
Th (232)
Tm 168.94
Sn 118.70
Ti 47.90
W 183.86
u 238.07
\Y, 50.95
Yb 173.04
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Valence

Equivalent Wt.

w NN W R W s NN W w

N N BB BN WA ERP W WO OUuN R

46.97
48.33
113
46.55
34.30
85.48
33.7
75.17
14.98

107.9
22.99
43.81
36.19
16.16
42.53
52.97
204.39
58.0
56.31
59.35
11.97
45.96
59.51
25.47
86.52



Appendix 2 - Returning an Instrument for Repair

If it is necessary to return any Metal Samples instrument for
repair, the following procedure is recommended to ensure the
fastest possible repair and return cycle. You may contact Metal
Samples to verify that returning the instrument is necessary.

1. If possible, pack the instrument in the original shipping
carton. If the original carton is not available, pack the
instrument in a rigid cardboard or wood carton. Sur
round the instrument with a minimum of three inches
of resilient packing material such as foam rubber or
shredded newspaper.

2. Ship the instrument prepaid via air freight or air
express to:

Metal Samples

152 Metal Samples Rd
Munford, AL 36268
Phone: (256) 358-4202
Fax: (256) 358-4515
E-mail: msc@alspi.com

3. When the instrument is packed, include a copy of the

form on the next page, filled in as required to expedite
the repairs.
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Copy this form when you need to return an instrument. Send a
copy of this form filled in as completely as possible.

1. Check one:

Repair this instrument under warranty.

Repair this instrument regardless of problem or cost of
repair.

Inspect this instrument and advise customer of
approximate cost of repairs if instrument is not covered
under warranty.

(Note: This may delay return of instrument to customer.)

2. Instrument Model #:

Serial #:

Date of purchase:

Customer’s original purchase order #:

3. Return this instrument to:

Company:

City/State/Zip:

Telephone:

E-mail:

4. Describe problem fully - this may shorten repair time.

5. Urgency of repairs:
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Appendix 3 - Warranty

Metal Samples warrants that any part of Metal Samples corrosion
rate instruments and accessories which proves to be defective in
material or workmanship within one year of the date of original
shipment to Purchaser will be repaired or replaced, at the option
of Metal Samples, free of charge. This warranty does not cover
(1) probe assemblies, (2) items expendable in nature, or (3) items
subject to damage from normal wear, misuse or abuse, or failure
to follow use and care instructions.

All damaged items are to be shipped at Purchaser’s expense to
and from Metal Samples. Metal Samples shall have the right to
final determination as to the existence and cause of the defect.

The foregoing shall constitute the sole and exclusive remedy of
any purchaser of Metal Samples products for breach of warranty
and is exclusive and in lieu of all other warranties, expressed,
implied or statutory, including the implied warranties or
merchantability and fitness. In no event shall Metal Samples be
liable for special or consequential damages or for any delay in the
performance of this warranty due to causes beyond its control.

Orders or requests for additional information should be addressed
to:

Metal Samples

152 Metal Samples Rd
Munford, AL 36268
Phone: (256) 358-4202
Fax: (256) 358-4515
E-mail: msc@alspi.com

The technical information and suggestions contained herein are

believed to be reliable, but they are not to be construed as war-
ranties since conditions of use are beyond our control.
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